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Getting Started with SAAM II Numerical 
 

Prerequisites 

 

This tutorial has no prerequisites. It assumes you know the basics of the Windows 

operating system. It also assumes you have SAAM II’s Numerical application installed 

on your computer, and that you know how to open the application. 

 

What you will learn in this tutorial 

 

The basic operations of the SAAM II Numerical application: 

 

 How to use a SAAM II Numerical study file. 

 How to use SAAM II Numerical computational features. 

 How to view solutions. 

 How to create a Sum of Exponentials model. 

 How to enter data, and associate data with the model. 

 How to enter model parameters. 

 

 

Files Required 

 

Study File:  

study_0.nst 

 

This file is the same as study_0.nst that is installed in the SAAM II program 

folder, and referred to in the SAAM II examples. 

 

Data Files: The data file for this tutorial is 

 

study_0.dat 

 

The data file is a text file. (This file is the same as study_0.dat that is installed in 

the SAAM II program folder, and referred to in the SAAM II examples and 

tutorials.) 

 

 

 

 

 

 

 



Introduction 

 

This tutorial will show you how to perform the basic operations in the SAAM II Numerical 

application. It is intended to help the new user get started quickly with SAAM II.  

 

This tutorial is divided into two parts. In the first part, you will load an existing SAAM II file. 

The purpose is to familiarize you with the basic computational operations, and how to view 

information from solutions. In the second part, you will build a model. This will familiarize you 

with the tools used to build models and create experiments.  

 

In this SAAM II tutorial, special information or notes to assist the user in the 

Numerical application are preceded by the Numerical symbol on the left and end with 

the small Numerical symbol. 

 
 

Part 1.  Using a Numerical Application Study File 

 

This part of the tutorial will show the key components of a numerical model specified by a sum 

of exponentials, the basic computational operations of SAAM II, and how to view information 

from solutions. You will work with the following sum of exponentials model: 

 

ya(t) = A1*exp(-a1*t) + A2*exp(-a2*t) 

 

This model is appropriate to explain a decaying set of data following, for example, a bolus 

injection into plasma. 

 

1. Start the SAAM II Numerical application. 

 

2. Open the SAAM II Numerical study file study_0.nst. 

 

The file study_0.nst should appear in the file list; if it does not, find the folder where you 

put this file. 

 

In the File menu, click Open. 

 

The SAAM II Numerical main window will open as follows: 

 



 
 

The model is the SAAM II Numerical representation of a two-exponential model. The 

model is characterized by two coefficients, A1 and A2, and two exponentials, a1 and a2. 

 

Auxiliary equation. SAAM II will automatically create auxiliary equations when the 

model is specified using the SAAM II Toolbox. In this case, the model is specified to 

explain data following a bolus injection into plasma. The auxiliary equations estimate 

the zero time value (ya(0)), the area under the curve (AUC), the normalized area 

under the curve (nAUC), the fractional clearance rate (FCR), and the mean area under 

the curve (MAUC). These values can be used to calculate the noncompartmental 

parameters, especially in pharmacokinetic studies. 

 
 

The SAAM II Numerical main window consists of four main areas: 

 

The Menu bar: 

 

 
 

This menu bar contains the SAAM II menu items. 

 

Below the Menu bar is the SAAM II Toolbar: 



 

 
 

This toolbar contains SAAM II specific tools such as “Solve” or “Fit.” Most of the 

toolbar functions can also be found in the Show and Compute menus. 

 

The Equation area is shown below: 

 

 
 

The Equation area contains the area for writing algebraic equations. 

 

The SAAM II Toolbox: 

 

 
 

The SAAM II Toolbox contains various algebraic modeling tools. Equations lets you 

add predefined equations to the model. Functions lets you add standard mathematical 

functions to the model equations. Operators lets you add standard arithmetic, relational 

and miscellaneous operators to the equations. The SAAM II Toolbox will be discussed 

in detail in the next part of this tutorial. 

 

Take a minute to examine the tools available on the Numerical Toolbar and in the 

Toolbox. Place the cursor on top of a SAAM II tool to show text describing the tool’s 

function. 

 



 The Numerical model: In the SAAM II Numerical application, the model is specified 

by algebraic equations. There is no counterpart to the system model and experiment 

as described for the SAAM II Compartmental application. Thus there is no 

counterpart for an exogenous input or sample. However, the model must be 

associated with data in a manner similar to associating a sample with data in SAAM 

II Compartmental. 

 
 

3.  Associating model variables with data. 

 

a. In the Show menu, click Associations. The Associate Variables and Data dialog 

box will open, as shown below: 

 

 
 

Associating variables and data dialog box: The Associate Variables and Data dialog 

box consists of two panes. The Variable Names pane contains the variable names as 

specified in the Equation Area, and the Data Names pane contains the data names 

found in the data file. In the left pane, notice "ya(t):plasma.” This shows that the 

variable ya(t) is associated with the data "plasma.” During “Fitting,” the parameters 

characterizing ya(t) will be adjusted to obtain a best “Fit” to the data, "plasma.” 

 

There are two operations the user can perform using this dialog box. One is Associate 

and the other is Sever. To associate a variable with a data name, click first on the 

variable, e.g. AUCa, then the data name, e.g. plasma, and then Associate. The 

variable name and data will appear in the left pane similar to "ya(t):plasma.” To sever 

an association, click on the associated pair, and click, Sever. The variable name and 

data name will return to their respective panes in the dialog box. 

 



In the SAAM II Compartmental application, associated data names with variables is 

done using the Sample tool. 

 
b. Click Done to close the dialog box. 

 

4. View the data. 

 

Data in SAAM II are entered as a text file where columns are space delimited. The data 

file for study_0.nst can be viewed as follows: 

 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar click Data 

. The Data window will open as shown below: 

 

 
 

The first line of the data file is the word “DATA.” The next line, (FSD 0.1) specifies 

the weighting method assigned to the data. The first column in the data file is always 

the independent variable, usually time, denoted t. The columns representing data can 

be named whatever you wish; the name is case sensitive. The name of this column 

must be same as the name in the appropriate Associate Variables and Data dialog 

box.  

 

 Data weighting. Data weighting is used to provide a measurement of the user’s 

confidence in a particular datum and is used in the “Fitting” process. Data weights are 

calculated as the inverse of the data variance. SAAM II contains several variance 



models. If no method is explicitly specified, a fractional standard deviation of 0.1 

(FSD 0.1) is assigned as the variance model to each datum. 

 

 SAAM II calculates weight for each datum from the standard deviations you assign 

to your data. In the file above, the variance model, (FSD 0.1) means that a constant 

coefficient of variation (fractional standard deviation) of 10% is assigned to each 

datum. Therefore, for example, the standard deviation of the datum of 46780 is 4678. 

 
 

b. Close the Data window. 

 

4. View the model parameters. 

 

The model has four parameters: A1, A2, a1 and a2. These parameters are entered in the 

Parameters dialog box. 

 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar 

click Parameters . The Parameters dialog box will open as shown below: 

 

 
 



 Properties of parameters. There are several important features of the Parameters 

dialog box.  

 

i. Each parameter has a "Type" that is either “fixed” or “adjustable.” A fixed 

parameter is a parameter that is assumed to be known and does not change when 

the model is “Fitted” to the data. An adjustable parameter is adjusted when the 

model is “Fitted” to the data. 

 

ii. Each parameter, whether fixed or adjustable, has a "current" value; this is the 

value that will be used when you Solve or Fit the model. 

 

iii. Adjustable parameters have upper and lower limits. These are limits that cannot 

be exceeded when SAAM II Fits the model to the data. If SAAM II is Fitting the 

model to the data and a limit is reached, SAAM II will display a warning 

message. 

 

iv. To change a parameter value, double-click on the parameter name or click Edit. 

The parameter’s current Value, and Low and High limits, if it is adjustable, can 

be changed. To save the changes, click Save. 

 

v. There is an “adjust value” slider bar that lets you adjust the value of a specific 

parameter by simply moving the slider button to a different location on the bar. 

 
b. To close the Parameters dialog box, click Done. 

 

5. Solve the model. 

 

In the Compute menu, click Solve, or alternatively on the SAAM II Toolbar click 

Solve . 

 

 Solve. When you “Solve,” SAAM II uses the current values of the parameters to 

solve the algebraic equations characterizing the model. It is important to note that no 

numerical integration is performed in SAAM II Numerical. This is because there are 

no differential equations as is the case with SAAM II Compartmental. 

  

 During a “solve,” a Solve Status message will appear showing the status of the 

integration (“solving”). For small models such as this one, the message will appear 

and disappear extremely fast. For larger models, you can watch the progress. You can 

also choose to abort a “Solve.” 



 
 

6. View the solution to the model using Quick Plot. 

 

a. Highlight ya(t) in the Equation area to select it. 

 

b. In the View menu, click Quick Plot. 

 

The Quick Plot will appear on the Numerical Window as follows (notice that it is a 

linear plot): 

 

 
 

 

 Quick Plot. Quick Plot has preset defaults that you cannot change. As you can see 

below, when you use the Plot command, you have more flexibility in what you can 

plot and how you can plot it. 

 
 

c. To view this plot in the semi-logarithmic mode, in the View menu, click Semilog. 

The following plot will appear: 

 



 
 

d. Close the Quick Plot window. 

 

7. View the solution to the model using the Plot command. 

 

a. In the Show menu, click Plot, or alternatively on the SAAM II Toolbar click Plot 

. The Plot and Table Variables dialog box will open as shown below: 

 

 
 

Only the variables that are associated with data will appear. However, you can plot any of 

the variables in the model. 



 

b. In the Plot and Table Variables dialog box, select the List All Variables check box. 

All the variables that can be plotted will appear as follows: 

 

 
 

You can now select among the different variables for the Y-Axis for the plot. 

 

c. In the Plot and Tables dialog box, clear the List All Variables check box to clear all 

variables except ya(t):plasma. 

 

d. In the Variables for Y-Axis pane, click ya(t):plasma. The selection will move to the 

Current Selection pane as follows: 

 



 
 

e. Click Done. 

 

A plot similar to the Quick Plot will appear. 

 

8. Fit the model to the data and view the solution. 

 

Leaving the Plot window open. The Plot window can remain open during the “Solve” 

and “Fit.” The plot will be updated after a successful “Solve” or “Fit.” 

 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar click Fit 

. 

 

 Fit status. During a “Fit,” a Fit Status message will appear (on a fast computer, you 

may just see a flash). This is the counterpart to the Solution Status message you saw 

when you solved the model originally. The Fitting Status bar gives information both 

on the integration part of the “Fitting” and on the number of iterations. You can abort 

the “Fit” by clicking Abort. 



 
 

When you have “Fitted” the model to the data, the SAAM II Numerical main window 

with the Plot window should appear as follows: 

 

 
 

The new parameter values will replace the original estimates in the Parameters window, 

and the best fit of the data appears in the plot. (You can change the plot to semi-

logarithmic if you wish by clicking Semilog in the View menu - this is possible because 

the Plot window is open.) 

 

9. View the statistics associated with the “Fit.” 

 

a. In the Show menu, click Statistics, or alternatively, on the SAAM II Toolbar click 

Statistics . The SAAM II Numerical main window should appear with the 

Statistics window as follows: 

 



 
 

Note that the statistics, plot and model all appear. 

 

 Statistical information following a successful “Fit.” The Statistics window contains 

information about the “Fit.” It includes 

 

i. the final values for the parameters, their estimated standard deviation, percent 

coefficient of variation, and 95% confidence interval. 

ii. the final values for the derived parameters (these are the auxiliary equations that 

are functions of the A1, A1, a1 and a2), percent coefficient of variation, and 95% 

confidence interval 

iii the final objective values: 

 

 Final value of the objective function (this is the function that is minimized 

during the fitting process) 

 Scaled data variance (this is a number that is estimated during the “Fitting” 

process when you use relative weighting – the default option in SAAM II) 

 Values for AIC and BIC; these values are used in the model development 

process to help assess which model structure best fits the data 



iv. the Covariance matrix.  

v. the Correlation matrix. 

 

If, for example, you select the Correlation Matrix option in the Statistics window, the 

Correlation Matrix will appear in the lower half of the Statistics window. The 

Covariance Matrix or the values for the Objective will appear if you select one of the 

other options. 

 

It is particularly important to note that the derived parameters such as the area under the 

curve have statistical information associated with them. 

 
 

b. Close the Statistics window. Leave the Plot window open. 

 

10. Plot the weighted residuals associated with the Fit.    

 

a. On the SAAM II Toolbar, click Select Variables: 

 

 
 

The Plot and Tables Variables dialog box will open. Check the List All Variables 

check box, and select wres_y(t): 

 

 
 



Click Done. The following plot will appear. 

 

 
 

b. Change the scale of the plot by clicking Set scales on the SAAM II Toolbar: 

 

 
 

The Set Scales dialog box will open: 

 

 
 



Click the Set radio button for the X Axis, and set the Maximum equal to 9.5; click 

the Set radio button for the Y axis, and set the Minimum and Maximum 

respectively equal to -2 and 2: 

 

 
 

Click Done. Your plot will be updated: 

 

 
 

Return to your plot of plasma and model fit by using Select Variables on the SAAM II 

Toolbar, deselecting List All Variables, selecting s1:plasma, and clicking Done. Then 

change the scale by using Set Scales on the SAAM II Toolbar, setting both the X and Y-

axis to AutoScale, and click Done. 

 

 



11. Quit the SAAM II Numerical application.   

 

a. In the File menu, click Exit. 

 

b. Click No (you do not wish to save the file). 

 

 

 

Part 2.  Building models in the SAAM II Numerical Application 

 

This part of the tutorial will show you how to create the sum of two exponentials model used in 

Part 1. This part of the tutorial will show you how to use the tools in the SAAM II Toolbox to 

build models. 

 

1. Start the SAAM II Numerical application. The SAAM II Numerical main window will 

open as follows: 

 

 
 

2. Create the sum of two exponentials model. 

 

a. In the SAAM II Toolbox, click Equations. The Equation Builder dialog box will 

open as shown below: 

 



 

 The Equation Builder. The Equation Builder dialog box contains a number of model 

building options to make your modeling with SAAM II Numerical easier. The 

predefined equations are Michaelis-Menten, Scatchard, Sum of Gaussians, 

Polynomials, and Sum of Exponentials. Sum of Exponentials are further subdivided 

to help you model data following a bolus injection, a primed or constant infusion, or 

an input described by a general equation. 

 
 

In this situation, we are dealing with a sum of two exponentials following a bolus 

injection. Notice by default the options for Sum of Exponentials and Bolus input are 

selected. 

 

b. Change the entry in the Number of Terms box from “3” to “2.” 

 

c. Click Paste Equations. The following equations will appear in the Equation Area of 

the SAAM II Numerical main window: 

 



 
 

 Auxiliary equations. SAAM II will automatically create auxiliary equations when the 

model is specified using the SAAM II Toolbox. In this case, the model is specified to 

explain data following a bolus injection into plasma. The auxiliary equations estimate 

the zero time value (ya(0)), the area under the curve (AUC), the normalized area 

under the curve (nAUC), the fractional clearance rate (FCR), and the mean area under 

the curve (MAUC). These values can be used to calculate the noncompartmental 

parameters, especially in pharmacokinetic studies. 

 
 

3. Define the experiment. 

 

a. In the Set menu, click Experiment Attributes. The Experiment Attributes dialog 

box will open as shown below: 

 



 
 

b. Change the entry in the Units box from “minutes” to “days.” 

 

c. Enter “9” in the End at box. The Experiment Attributes dialog box will appear as 

follows: 

 

 
 

 Experiment Attributes. The Experiment Attributes dialog box is normally where 

you set the ending time of the experiment. Units are for convenience only. Start at is 

normally zero which is the time of the first test input. End at is normally the time at 

which the experiment ends. There are, however, occasions when you may wish to set 

End at to a larger value. 

 
 

d. Click Done. 

 

4. Add the data to the SAAM II Numerical model. 

 

The data you will use are in the data file study_0.dat. 

 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar click Data 

. The Data window will open. 

 



b. In the File menu, click Open. The file study_0.dat should appear in the list (if it does 

not, find the folder where you put this data file). 

 

c. Double-click study_0.dat. The data in this file will appear in the Data window. The 

SAAM II Numerical main window should appear with the Data window as follows: 

 

 
 

d. Close the Data window. 

 

 Error structure of the data. For this introductory tutorial, the errors in the data are 

assumed to be a constant coefficient of variation; this is denoted in the data file by 

(FSD 0.1). 

 
 

5. Associate the variable ya(t) with the plasma data. 

 

a. In the Show menu, click Associations. 

 

b. Click ya(t) in the Variable Names pane, and then click plasma in the Data Names 

pane. 

 

c. Click Associate. 



 

The Associate Variables Name and Data dialog box should appear as shown below: 

 

 
 

 Associating a variable with data. A successful association is indicated by the 

"ya(t):plasma" pairing in the Variable Names pane. 

 
 

d. Click Done. 

 

6. Enter the parameter values. 

 

The parameters for the model are A1, A2, a1 and a2. 

 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar 

click Parameters . The Parameters dialog box will open, as follows: 

 



 
 

The parameter A1 should be selected. If it is not selected, double-click A1 to select it. 

Be sure the Adjustable option is selected. 

 

b. Enter "40,000" in the Value box, and click Save.  

 

  Default low and high parameter limits. Notice that when a value is entered in the 

Value box and nothing is entered in the Low Limit or High Limit boxes, the default 

low and high limits of one tenth of the value and ten times the value respectively are 

automatically entered when the value is saved. 

 
 

c. Double-click A2 to select it. 

 

d. Enter "10,000" in the Value box, and click Save. 

 

e. Double-click a1 to select it. 

 

f. Enter "0.5" in the Value box, and click Save. 

 



g. Double-click a2 to select it. 

 

h. Enter "0.05" in the Value box, and click Save. 

 

When you have finished, the Parameters dialog box should appear as follows: 

 

 
 

i. To close the Parameters dialog box, click Done. 

 

  Single or double-clicking a parameter in the Parameters dialog box. When the 

Parameters dialog box is open, there is always a current parameter. Its name appears 

in Name: in the lower pane. The Value, Low Limit and High Limit boxes will either 

contain the values associated with the current parameter or be empty if no values have 

been entered. 

 

If you single-click on another parameter, the Name of the current parameter will not 

change nor will the entries in the Value, Low Limit and High Limit boxes. 

However, if you click Save, the current Value, Low Limit and High Limit shown in 

the boxes will be saved for the new parameter. This makes it easy to enter the same 

values for more than one parameter. 

 



If you double-click on another parameter, the name of the new parameter will appear 

in Name:. The Value, Low Limit and High Limit boxes will change to the values 

associated with this parameter. If no values were entered for this parameter, these 

boxes will be cleared, and you can enter the new values for this parameter. 

 
 

At this point, you have successfully created the study file study_o.nst that was used in Part 1 

of this tutorial. If you wish, you can repeat Part 1 (we recommend you start at Step 5 with 

“solving”). If you wish to quit the SAAM II Numerical application: 

 

7. Quit the SAAM II Numerical application, or repeat the steps in Part 1. 

 

a. In the File menu, click Exit. 

 

b. Click No. 



Data for this tutorial 

 

DATA 

(FSD 0.1) 

t plasma 

0.007 46780 

0.042 43522 

0.125 42535 

0.25 40125 

0.375 36221 

0.5 35562 

1.0 28194 

2.0 19573 

3.0 14403 

4.0 11278 

5.0 8081 

6.0 6999 

7.0 5653 

8.0 5139 

9.0 4210 

END 
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